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1 Introduction

The International Seabed Authority is an autonomous international organisation established under the 1982
United Nations Convention on the Law of the Sea and the 1994 Agreement relating to the Implementation
of Part XI of the United Nations Convention on the Law of the Sea. The Authority is the organisation
through which States Parties to the Convention shall, in accordance with the regime for the seabed and
ocean floor and subsoil thereof beyond the limits of national jurisdiction (the Area) established in Part XI
and the Agreement, organise and control activities in the Area, particularly with a view to administering the
resources of the Area.

The Authority came into existence on 16 November 1994, upon the entry into force of the 1982

Convention. The first Secretary-General of the Authority, Satya Nandan (Fiji) was elected in March 1996,
and the Authority became fully operational as an autonomous international organisation in June 1996, when
it took over the premises and facilities in Kingston, Jamaica previously used by the United Nations

Kingston Office for the Law of the Sea since 1983

In view to administer the resources of the area, a group of pioneer investors under co-ordination by the
United Nation Convention on the Law of the Sea department (UNCLOS) has already surveyed 2 areas
located near the Clipperton fault in the Pacific and in the Indian Ocean. During the same period, numerous
scientific cruises have collected mineral data all over the world.

The Authority has collected this data and applications under various forms, mainly paper format. The
current Geographic Information System (GIS), developed here has for purpose to finally organise the data
collected during these years as to manage the future mining ( by August 1997).

This GIS should create a synergy between potential investors and the Authority, offering a common
interface for nodule and mineral data requests on the areas managed by the Authority. This GIS should
finally promote the scientific and technical role of the authority to member countries, investors and the
public in general.
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2 Reference Manual

2.1 Relationships
The table structures as well as the relations between tables are organised as below:

[_ (O] x|

=7 Relationships

; ample Tupe
Station ID
Sector ID MAPIMNFO_ID
Event Date Sector 1D ' - List Sampling D...
1 Event Data Compiler I—I .
D Skation ID
Address DC Cruise ID =
City Sector ID Latitude 51 ccsan 1/e
Zip Code oo MAPIMFC_ID Laongitude ISa:hun Type
Courtkry Contract ID Water Depth
Postal AFIdress Skatus Abundance
Postal C.lty Surveyor Sample Type
Postal Zip Code Ciogan Area Sampling Device
Postal Courtry Surface Section Type
Tel Application Date Mucleus
Fax approveal Dake Maorphology
TB|E><_ Relinquishrment Date Texture
E—m.a|l . Fioneer Lithalogy
Mationality Reserved Area 1N %
Flace of registration Confidential Mn ppr
Flace of business Methodology Mn Analysis
Sponsaring States Canmmients Fe %
Representative Fe ppm
Representative Address Fe Analysis
Representative Ciky Co %
Representative Zip Code ﬂ Co pprm
Representative Counkry o Analysis
Representative Postal Address i %
Representative Postal Ciky i pprn
Representative Postal Zip Code ﬁ Mi Analysis =
Representative Postal Country U e 2 £
Representative Tel Cu ppr il
Representative Fax Cu Analysis Analysis
Representative Telex Zn %
Representative E-mail Zn ppm
Comments Zn Analysis
Pb %
Fb ppm
-
] v
2.2 Tables
The Polydat GIS is composed of 4 core tables:
» Sectors
»  Sector Event
+ Stations
e Surveyor

The subsequent tables prefixed by list are lookup tables to enforce data integrity in the core tables. These
list tables dictate operator input.

Referential Integrity is enforced between the 4 core tables to ensure cascading changes when Identifiers and

list values are modified.

2.2.1 Sectors

| FieldName |

Type | Size |

Description
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Sector ID Text 50 Sector ldentifier

MAPINFO_ID Long 4 Mapinfo Internal Identifier link to geographic object
Contract ID Text 50 Contract Identifier (eg Contract Number or Prospection
Status Text 12 Status for the Area (Prospection, Exploration, Extension)
Surveyor Text 50 Organisation identifier

Ocean Area Text 50 Name of Ocean area where is the Area

Surface Double 8 Surface of the Area in sqgkm

Application Date Date/Time 8 Date of the Application

Approval Date Date/Time 8 Date of Authorisation

Relinquishment Date | Date/Time 8 Date of Relinquishment of the data

Pioneer Yes/No 1 Pioneer Area

Reserved Area Yes/No 1 Area is Reserved for the Entreprise

Confidential Yes/No 1 Data is confidential

Methodology Memo 0 Methodology of extraction and exploration

Comments Memo 0 General Comments

This table describes the different reserved areas.
The sectors fall in several categories depending on the status of the application. The mining code specifies:

Mining code (ISBA/3/LTC/WP.1/Rev.1), Regulation 21

The Contractor shall relinquish portions of the area allocated to revert to the area, in accordance with

the following schedule:

(&) 20 per cent of the area allocated by the end of the third year from the date of the contract;

(b) an additional 10 per cent of the area allocated by the end of the fifth year from the date of the
contract; and

(c) an additional 20 per cent of the area allocated or such larger amount as would exceed the
exploitation area decided upon by the authority, after eight years from the date of the contract.

In the case of registered pioneers, they fall in the same schedule starting at the time of their registration.
However the status of the area should be flagged as a pioneer area.

The different categories which the areas will be classified are as follow:
(a) Prospecting

(b) Exploration Area applied

(c) Exploration Area after first Relinquishment

(d) Exploration Area after second Relinquishment

(e) Exploration Area after third Relinquishment

(f) Exploitation Area

Therefore the GIS, for mapping purposes, will hold several areas with the same contract number. Each area
will be defined by the list of co-ordinates submitted to the Authority before application and after each
relinquishment. The application date, approval date and date of relinquishment drive the monitoring of the
contract. Areas active will be extracted by querying areas which approval date is earlier than the current
date and which relinquish date hasn’t yet expired. This system will allow fast confirmation by the Authority
of free areas, which could be reserved.

The Sector ID and Contract ID are left to the Authority to decide which classification they will use for
recording the different areas.

The table is mappable in Maplinfo. The default co-ordinates system is geodesic co-ordinates referenced by

the World Geodetic System of 1984 (WGS84). The Maplnfo object will define the perimeter of the sector
as well as its co-ordinates.
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2.2.2 Sector Event

| FieldName |  Type |Size] Description
Event ID Long 4| Automatic Identifier

Sector ID Text 50 Sector Identifier

Event Date Date/Time 8 Date of the Event

Event Memo 0 Description of the Event

This table describes events associated with the management of the application, such as reception of reports,
confirmation letters, reception of data and reception of various documents.

2.2.3 Stations

| FieldName |  Type |Size ] Description |
Station ID Text 50 ISA Station Identifier

MAPINFO_ID Long 4 Maplnfo Internal Identifier link to geographic object
Sector ID Text 50 Sector Identifier

Data Compiler Text 50 Organisation compiling the Data

DC Station ID Text 50 Data Compiler Station Identifier

DC Cruise ID Text 50 Data Compiler Cruise Identifier if any
Latitude Double 8 Latitude of the sample (WGS84)
Longitude Double 8 Longitude of the sample (WGS84)
Water Depth Double 8 Depth of the sampling collection (WGS4 spheroid)
Abundance Double 8 Abundance of minerals in kg/sqm
Sample Type Text 50 Sample Type

Sampling Device Text 50 Sampling Device

Section Type Text 100 Section Type

Nucleus Text 50 Nucleus

Morphology Text 50 Morphology

Texture Text 50 Texture

Lithology Text 50 Lithology of the seabed

Mn % Double 8 Manganese percentage

Mn ppm Double 8 Manganese parts per million

Mn Analysis Text 2 Manganese analysis method

Fe % Double 8 Iron percentage

Fe ppm Double 8 lron parts per million

Fe Analysis Text 2 Iron analysis method

Co% Double 8 Cobalt percentage

Co ppm Double 8 Cobalt parts per million

Co Analysis Text 2| Cobalt analysis method

Ni % Double 8 Nickel percentage

Ni ppm Double 8 Nickel parts per million

Ni Analysis Text 2 Nickel analysis method

Cu% Double 8 Copper percentage

Cu ppm Double 8 Copper parts per million

Cu Analysis Text 2 Copper analysis method

Zn % Double 8 Zinc percentage

Zn ppm Double 8 Zinc parts per million

Zn Analysis Text 2 Zinc analysis method

Pb % Double 8 Lead percentage
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Pb ppm Double 8 lead parts per million

Pb Analysis Text 2 lead analysis method

Al % Double 8 Aluminium percentage

Al ppm Double 8 Aluminium parts per million
Al Analysis Text 2| Aluminium analysis method
Si % Double 8 Silicon percentage

Si ppm Double 8 Silicon parts per million

Si Analysis Text 2 Silicon analysis method
Ca% Double 8 Calcium percentage

Ca ppm Double 8 Calcium parts per million
Ca Analysis Text 2| Calcium analysis method
Water Loss Double 8 Water loss in percentage
Confidential Yes/No 1 Data is confidential
Comments Memo 0 General comments

This table records information about each sample or group of samples taken during the prospecting,
exploration or exploitation phase of the reserved areas.

The table is mappable in MapInfo. The default co-ordinates system is geodesic co-ordinates referenced by
the World Geodetic System of 1984 (WGS84)

2.2.4 Surveyor

| FieldName |  Type |[Size] Description

Surveyor Text 50 Surveyor Name

Address Text 255 Surveyor Address

City Text 50 Surveyor City

Zip Code Text 50 Surveyor Zip Code

Country Text 50 Surveyor Country

Postal Address Text 255 Surveyor Postal Address (if different from above)
Postal City Text 50 Surveyor Postal City (if different from above)

Postal Zip Code Text 50 Surveyor Postal Zip Code (if different from above)
Postal Country Text 100 Surveyor Postal Country (if different from above)

Tel Text 50 Surveyor phone number

Fax Text 50 Surveyor fax number

Telex Text 50 Surveyor telex

E-malil Text 200 Surveyor e-mail

Nationality Text 100 Nationality of the applicant

Place of registration | Text 255 Place of registration if the Surveyor is a juridical person
Place of business Text 255 Place of business if the Surveyor is a juridical person
Sponsoring States Text 200 States sponsoring the Surveyor for exploration or exploitation
Representative Text 50 Surveyor Designated representative (if different from above)
Representative Text 255 Representative Address

Representative City | Text 50 Representative City

Representative Zip Text 50 Representative Zip Code

Representative Text 100 Representative Country

Representative Postal | Text 255 Representative Postal Address

Representative Postal | Text 50 Representative City

Representative Postal | Text 50 Representative Zip Code
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Representative Postal | Text 100 Representative Country

Representative Tel Text 50 Representative phone number
Representative Fax | Text 50 Representative fax
Representative Telex |Text 50 Representative telex
Representative E-mail | Text 200 Representative e-mail
Comments Memo 0 Comments

This table records information about the prospector or explorer as specified in Annex 1 and Annex 2 of the
Mining Code (ISBA/LTC/WP.1/Rev.1).

2.2.5 Lookup Tables

|  TableName | FieldName | Type |Size | Description
List Analysis Analysis Code Text 2| Analysis Code (NGDC)
List Analysis Analysis Text 100 Analysis method

List Country Country Text 50 Country name

List Lithology Lithology Text 50 Lithology of the seabed
List Morphology Morphology Text 50 Morphology of the sample
List Nucleus Nucleus Text 50 Nucleus Type

List Ocean Area Ocean Area Text 50 Ocean Area Name

List Sample Type Sample Type Text 50 Sample Type Name

List Sampling Device Sampling Text 50 Sampling Device

List Section Type Section Type Text 100 Section Type of the Nodule
List Texture Texture Text 50 Texture of the sample

Most of these lookup tables are based on the National Geographic Data Center (NGDC) codification, which
is an extension of the codification, used by the Scripps Institute of Oceanography (SIO).

2251 List Analysis
| Analysis |
PIXE (Proton Induced X-ray Emission)
Atomic Absorption spectrophotometry
Inductively coupled plasma atomic emission spectroscopy
x-ray diffraction, diffractometry
x-ray diffraction, powder camera
x-ray diffraction, single crystal
electron diffraction
Thermography
Alpha spectrometry
gamma ray spectrometry
UV spectrophotometry
calcimetry
Primarily ICP, except water, Platinum metals & oxides
wet chemical
specific ion electrode
atomic absorption spectroscopy (AA)
atomic absorption - graphite furnace
colorimetric
coulometric
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CHN analyzer (Carbon/Hydrogen/Nitrogen)
ion chromatography

neutron activation

INAA

RNAA

mass spectrograph

fluorimetry

semi-quantative spectrograph

x-ray fluorescence

other, see documentation

unknown

EDXA

quantitative emission spectrograph

Direct quantitative emission spectrography
Induced quantative emission spectrography
calculation

fire assay - neutron activation

flame photometry

assay

microprobe analysis

x-ray emission used by SIO

gravimetric

polargraphy

2252 List Lithology

| Lithology

Biogenous Sediment
Calcareous clay

Calcareous ooze

Calcareous terrigenous material
Calcareous-siliceous ooze
Coral

Hardened sediment
Manganese pavement
Metalliferous Sediment

Pelagic clay

Phosphorite

Rock

Siliceous clay

Siliceous mud

Siliceous ooze

Terrigenous material (sand, silt, mud, gravel)
Volcanic ash

Weathered basalt

Zeolitic mud

Zeolitic Sediment
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2253

2254

2255

List Morphology

List Nucleus

List Sample Type

| Morphology |
Biological

Discoidal
Ellipsoidal

Faceted

Irregular

Poly (coaspheridal)
Pyramidal
Scoriaceous
Spheroidal

Tabular

| Nucleus
Altered basalt
Chert

Clay

Coral

Earbone

Glacial erratic
Metallic object
Nodule fragment
None apparent
Ooze

Palagonite
Pumice

Rock, unspecified
Sediment, unspecified
Tooth

Unknown
Volcanic

Zeolite

Sample Type

metalliferous hydrothermal sediment
micronodules
micronodules in sediment
Mn coated organic material
Mn coated sediment

Mn crust or pavement

Mn encrusted sediment

Mn nodule in sediment

Mn nodule or nodules
nodules and micronodules
several crusts
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stratiform deposit
unknown

2256 List Sampling Device

| Sampling Device

4-inch graviti core

5-inch Gravity Core

Accidental recovery, towed vehicle
Biological Box Core

Biological Grab

Box Core

Box Dredge

Box Grab

Bucket Dredge

Camera Core

Catcher Grab (on camera or core)
Chainbag Dredge

Combined Chain & Pipe Dredge
Compressed Air Core

Core Catcher

Dart Core

Deeptow Photograph

Drill Core

Drill Sludge Sample

Explosive Core

Free Fall Grab

Free-fall Core

Gravity Core

Gravity Core with Heat Flow Thermistors
Gravity Oriented Core

Heat Probe

Manipulator (mechanical arm)
Miscelaneous Core

Miscelaneous Dredge or Drag Haul
Miscelaneous Grab

Multiple Core, up to 5 Gravity Cores
Multiple Photograph (>1 frame same station)
Orange Peel Grab

Peterson Grab

Phleger Core

Pipe Dredge

Piston Core

Piston Oriented Core

Push Core

Rock Dredge

Rotary Core

Sanpper Grab
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Scoop Bag

Shipek Grab

Side Wall Core

Soft Sediment Sampler

Sounding Grab

Spade Core

Submersible Undifferentiated

Survey (>1 frame, different stations)
Television or motion picture

Trawl

Trip Core (with Piston Core)

Triple Core (pre-1971)

Undifferentiated Deep Sea Drilling Project
Undifferentiated Grab Sampler

Unknown

Unspecified Dredge or Drag Haul
Unspecified Photograph (camera station)
Van Veen Grab

Vibrating Core

Von Herzen Core

2257 List Section Type

| Section Type

bulk composition - represents total material at surface location
composite 2-5 nodules or micronodules analyzed together
composite 6-12 nodules or micronodules analyzed together
composite of > 12 nodules or micronodules anlyzed together
core or nucleus of nodule

cross-section nodule

fragments or pieces

half nodule

inner part, without outer layer

layer adjacent to core of nodule

middle layer of nodule

nodule without core

one eighth of a nodule

outer layer or outer crust

point analysis (eg. Micropobe)

quarter nodule

sediment substrate

side of nodule or crust

split of bulk sample

topside of nodule or crust

underside of nodule or crust

unknown

whole nodule or crust
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2258 List Texture

| Texture

Botryoidal

Cavernous

Microbotryoidal

Rough (granular/microbotryoidal)
Smooth
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3 User Manual

3.1 Entering PolyDat Database

Polydat database is directly accessible from the hard drive. It is called polydat.mdb. Ms-Access 97 must be
installed on the computer.

3.1.1 Main Menu
The PolyDat Menu is composed of 4 parts. The first one allows the user to access the data entry and
consultations forms. The second part allows the user to formulate advanced queries. The third part allows
the user to print reports. The last part allows the user to switch to Maplinfo as well as to manage the access
to all components of the database.

Poly Metallic Hodules Menu

Poly Metallic Nedules MENU |

Adrmin : 21-Jul-1997

Entry Forms Queries Reports Utilities
Sectors ] e Stations Queries Sectors Mapinfo
i1 -- =
Stations Sectors by & Chanie
| | Burveyars gl Password
Surveyors _'S'eéto = with Area Erofile
- |2
Stations ﬁ e
Surveyars
Eﬂ Full Access
Sectors Statistics ] Setup
7@ lterns

Exit International
SUPHE ‘ @ Database  Seabed Authority
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3.1.2 DataEntry

3121 Sectors Form

B Sectors =] E3
Sectors ‘ ‘ '&" e

> Sectar D D0 AP Contract |0 |02
Status |EH|:I|DT1 _"J Surveyar ||:|:|MH.":". _"J
Oceanérea  [Mortheast Pacific »| Surface 43410, 758354 2q km
Application Date [ 05-b ar-91 Approval Date | 05-k ar-91 Felinguizhment Ciate | 05-bd ar-94
Fioneer v Reserved drea ¥ Confidential v
Highendag Longitude Latitude
4 203625 10625

| 203625 | 10,875

| 203.875 | 10.875

| 203.875 | 10.375
Comments

| 204125 | 10.375

| 204125 | 10125

| 203.875 | 10125

| 203,875 | 9.875

[ =Tl | e ﬂ

Record: 14| 4 | 1k | M |k*%|af 45

The sectors form records each sector and its derived relinquished sectors. Each sector is valid until its
relinquishment date unless it is a reserved area. When a sector is relinquished, the operator should create a
new sector with the same number in the Sector ID, but different letters classification. It will therefore be
possible to follow each sector and its future relinquishment through the first 4 character of the Sector ID.
The operator mustn’t enter the relinquished area, but the area still reserved to the surveyor after it has been
relinquished.

The Sector ID codification is as follow:
DDDDAAB
DDDD: Sequential number unique for each Sector.

AA: AP Application; R1 sector after first relinquishment; R2 Sector after second
relinquishment; R3Sector after third relinquishment; EX; Exploration; MN:
Mining

B: R Reserved to the Authority; P Pioneer investor sector; N Normal.

For Example:
0023APN Original sector

0023R1N Same sector minus first relinquishment area
0023R2N Sector minus second relinquishment area
0023MNN Sector with a mining licence
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3122

Stations Form

H Stations i |
Stations ‘ ‘ R+
> Station 1D | 116 Sector D l-m | |coMR&
[rata Compiler Station 1501 Cruize

Longitude 2042443206

Latitude 10.99550001
Ahundance .8 kafzqm

P Lz -
Zni 1

Fe &na -
Ph & B

Codna -
Al E B

Wwater Depth 2115 /m

Sample Type | _:J Sampling Device | _:_J

Section Type | _-_J Mucleus | _v_J

Marpholagy | j Texture | j

Lithology | _:J

Mnz [ ®2z  Fex [ 4 Cox [ 014 Nz [ 1 cux [ 0%
i ppn |71 Fe ppr Ii‘l Co pprr -1 Mi ppm |71 Cu pprr |—1

Midnal -
SiE 1

Zn ppre I‘_‘_‘_‘_‘_‘_‘T FPb ppre l._._._._._._.__l._ Al ppm ’_‘_‘_H—H_:l_ Sippm ]_._._._._._._.1_ Ca pprr li'l
Zn Ana I—__v_[ Pb Ana I—_v_[ Al Anal ’—_v_[ SiAnal I—__v_l T I—_,J
wiater Loss |—1
e e
Cornrmehts

Record: 14 4 1k [l |k*]|of 2021

Each Sector contains a number of Stations collecting information about the seabed nodules. For element
analysed, a value of —1 means that the element was not analysed while a value of 0 means no traces of this
particular element were found.
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31.23

Surveyors Form

B3 Surveypors H=] B

Surveyors | e
4 Surveyurllil|'|'.1’_‘!- Posztal Addiessz
Address | Address
City I Zip Code I City I Zip Code I
Countmy | ;l Country | ;l
Tel I Fax I T elex I
E-mal |
M ationality | ;I
Place of registration I Flace of buziness

Sponsoring States

China

Reprezentative

| Postal Addiess

Address I Addressz
City I Zip Code I City I Zip Code I
Country | ;l Country | ;I
Tel I Fax I Telex I
E-mail I
Comments
Record: 14| 4 II 1k |et]e#]|of 7 o

This forms record information on each surveyor as requested in the draft mining code.

3.1.3

Notes on Forms
Forms are designed to be user-friendly, and the user should be aware of the following:

Fields - these are the items of information to be stored in the database. Each time a new
record is entered on a form, a new line of data is put into one or more underlying tables.

Status Bar - If the user is not sure what to enter in a field, the status bar at the base of the
screen will display the definition of the field that currently has the focus (i.e. which box

on the form contains the cursor).

Navigation buttons - these help the user to move or ‘navigate’ through the records.

Other Buttons - these are usually located at the top right-hand side of the screen.
Different symbols mean different actions e.g. closing door means ‘close the form.” A pair

of binoculars means ‘Find a particular record.’

Combo boxes - A combo box can make data entry easier, quicker, and more accurate by
presenting a scrollable list from which values can be directly picked.
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« Error Messages - to ensure data quality, there are built-in rules concerning the values data
can be stored as. Some of these are summarised below.

Error Message Applies to:

“The value you entered isn’t appropriate for the field”  Fields whose underlying data type is different from the
data you tried to enter. For example if you tried to
enter text into a field whose data type is defined as a
Number.

“The value you enter must match an entry in the list” This applies to Combo Boxes when you try to enter a
value that is not in the list, which is not acceptable for
the list.

“The value you entered isn't in the list - do you warithis applies to Combo Boxes when you enter a value
to add it?” that does not occur in the list, but which is accepted if
you want to add it.

# Name? The name entered as the source of the value in the field
is invalid. For example, you may have entered an
invalid name or expression for the ControlSource
property: The name may be misspelled, you may have
omitted the equal sign (=) before the expression, or the
source itself may have been deleted.

Other causes include the following: The field name
may not match the name of a field in an underlying
table or query. A control may have the same name as
one of the fields in the underlying table or query. An
expression designed to calculate a sum for a control
might include a Sum function (which can be used to
calculate sums for fields only, not controls).

# Error Microsoft Access can'’t evaluate an expression used.
# Deleted If you are working on the database at the same time as

somebody else, this is the message that is displayed for
a record that no longer exists because it has been

deleted.
Custom Messages These depend on the underlying validation rule; in this
e.g. “Value must be either Appl, initial applicatiom;ase, the data that can be entered into this field is
Renl, first renewal or Ren2, second renewal. restricted to one of three values.

3.1.4 Queries

3141 Filter By Form Queries

Each from contains a filter by form button. This button allows simple queries by filling values in a blank
form. For instance to select all records in the Indian Ocean, click on the filter by form button, select Indian
Ocean in the Ocean Area combo box, and apply the filter.

3.14.2 Stations Queries
This forms allows high level queries such as compute a market value of the nodules, and sort nodules by
cut-off values, as well as display the grade of each nodule.
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B3 Stations Quernes Hi=] E3

Stations Queries jle \

Sector 1D || 1 |
Abundance »=| 0.00 “Water Depth <= 15000.00

Elements Percentages
Wihere | 1.00 :-:h-'ln+| 1.00 % Fe +| 1.00) % Ca +| 1.00 & Mi + 1.00 % Cu = Q.00
And bl = -1.00 Fe>=| -1.00 Eu:u>=| -1.00 Ni>=| -1.00 Cu >=| -1.00

Elements ppm
YWhere | 1.00 :-:Mn+| 1.00 :-:Fe+| 1.00 :-cD:u+| 1.00 % Mi+ 1.00 % Cu x= 0.00

And  Mne=| .00 Fer=| -1.00 Co> -1.00 Miz| -1.00 Cuz=| -1.00

Grade Abundance Mi+HCu+Co Elements Percentages Elements ppm

& »10 »25
E »10 225
E 510 2.5
D 510 225
E
3.1.5 Reports

3.151 Forms report
Each form contains a report button. The report created contains all the records currently visible in the form.
It is a great tool to select records with the filter by form button and then produce a corresponding report.

3.15.2 Sectors report
This report lists all sectors with their turning points as in the sector form.

3.153 Sectors by Surveyors report
This report classes the sectors by surveyor name and in 2 categories depending of the sector status if it is
reserved for the Authority or not.

3154 Sectors with Area Report
This report is particularly useful for verifying the turning points of each Sector.

3155 Stations report
This report prints information of each station in the same format as the form.

3.156 Surveyors report
This report prints information for each surveyor in conformance with the mining code.

3157 Sectors statistics report
This report prints statistics on each sector: average abundance, potential mining...

3.1.6 Utilities
There are five buttons, providing different facilities which are summarized briefly below:

* Maplnfo - starts a Maplnfo session
* Change Password - allows the user to change their password

» Profile - allows the user to set the correct drive path for loading data into MapInfo and in
Access.
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« User Management - assign a new user or change permissions - Database Manager only.
» Full Access - access to the actual workings of the database - Database Manager only.

* Setup Items — Create a shortcut in the start menu on Windows 95 for easy access to the
database.

3.2 Entering PolyDat GIS

3.2.1 The Map System

To ensure the maximum coverage of the oceans, all data is stored in the longitude range: 0-360 degrees. All
co-ordinates are in the World Geodetic System of 1984 (WGS1984). Mapinfo allows changing projections
and spheroid, but the operator must respect the coherence of the raw data to this datum.

3.2.2 Maplnfo Interface

#7 Maplnfo Professional M= E
Menu File, Edit Objects Query Table Optione Browse window Help PolDat -
Bar Dzl & ielE o B EEE el 4‘ ?gz‘l"ggf
- WRDWVYS Stations. 5 ectors Map —
= DX &
Mapper }—
s | | [Tools
& . D
0 ‘ toolbar
A
HE
42|~z | [PolyDat
& Toolbar
| |Main
PaluDat [] Toolbar
LY
Browser i_ 2| @] ®&|
EE Sectois Browser M= E3
Sector_ID Contract_ID Status -
1| o0448PR m Euplar =
| o0454PR o Explar
Status ‘ O] o0464PR il Explar]
Bar 1] no01AFPR: 02 Euplor
[ ] O] ageerr i Explort
5] DDDB@ ] Explort hd
] ’
| records 1 - 6 of¥6

3221 Opening a Table
I Menu Bar -> File -> Open Table

Several tables may be open at any one time; Maplnfo regards all information as Tables, whether the file is a
Maplnfo table, an ASCII file, an Excel or Lotus 1-2-3 worksheet, a dBASE table or a raster image. If the
data is tabular, the information will be presented in a browser, whereas if the selected file is a raster image,
then it will either be added to the current mapper, or will appear in a new one.

3222 Opening a Workspace
I Menu Bar -> File -> Open workspace

21 of 45



A workspace enables a user to save their activity to a file, which when opened resumes tasks as they were
left at the end of the previous session. Any objects left open at the end of the previous session will reappear
3223 The Main toolbar

in the same position in the MapInfo window.
Select }—\
I — “ Marquee Select
Radius Select }—\ .:-
| | I Zoom-Out |

Zoom-In | i
| iChange View | }_, —{ |Grabber |
T a—] [abel |
e — ,_‘ |Ru|er |

Layer Control }—/

Show/hide
Legend

3.2.2.3.1 The Info Tool

I |Statistics |

On selecting an object in the mapper, the info tool presents tabular data relating to the identified object.
3.22.3.2 The Select Tool

This appears as a pointer on screen, with which objects are selected by clicking the mouse.

3.2.2.3.3 The Marquee Select Tool

Objects within the mapper are selected within a user-defined rectangle by clicking and dragging with the
mouse.

3.2.2.34 The Radius Select Tool

Objects within the mapper are selected within a user-defined circle.
3.22.3.5 The Zoom In Tool

This can be used to magnify all or part of objects in the mapper.
3.2.2.3.6 The Zoom Out Tool

This does the opposite of the above tool.

3.2.2.3.7 The Change View Tool

Allows the user to specify the centre of the mapper as well as the scale.

22 of 45



Change View

3.2.2.3.8 The Grabber Tool

This allows a map to be moved around interactively.
3.2.2.3.9 The Layer Control Tool

This controls which layers are visible in the mapper window.
3.2.2.3.10 The Ruler Tool

Allows distances to be measured between two points on a map.
3.2.2.3.11 The Label Tool

This is used to label objects in a mapper.

3.2.2.3.12 The Statistics Tool

Displays statistics of selected objects.

3.2.2.3.13 The show/hide legend tool

Displays the legend window.

3224 The Drawing Toolbar

|Symbol | Line

Arc
|Po|y|ine |

Ellipse
|Polygon | Rounded
Rectangle Rectangle
| | Frame
Text

Line Style
|Symbo| Style |

Text Style
|Region Style |

3.2.24.1 Adding Frames

The frame tool enables the addition of a further mapper or other window available within the Maplinfo
Workspace

23 of 45



3.2.2.4.2 Adding Text on the Layout
Text or graphics may be added to the layout.
3.2.24.3 Selecting the Scale

Double clicking on the frame containing the mapper presents a window containing the parameters of the
frame, where a valid scale can be specified.

Change View Ed |

Zoom [MWindow Swidth]: -'1_.55I:I km
Map Scale: 1 cocms= |339.1 i
Center of Window: = |222.1 3] deg Y. I'I 217 deg

k. I Cancel | Help |

Specify here the
scale

3225 Changing the view of a map
I Menu Bar -> Map -> Options

Map Options Ed |

—Map Unit I
ap Uitz oK
Coordinate Uitz qrees Cancel |
Distance Units: Ikilnmeters j
Projection... |
Area Units: Isquare kilometers j
Help |
— Dizplay in Status Bar——— YWhen Besizing "Window:
= Zoom [Window Width) = Fit Map to Mew Window
i~ Map Scale i~ Preserve Current Scale
¢ Cursor Location

[~ Scroll Bars

3.2.25.1 Changing Map Units
Here the default unit system of the mapper can be changed.
3.2.2.5.2 Changing the Projection

A different projection for the mapper can be selected, although since some projections are only local, care
should be taken when selecting alternative projections for wider maps.
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3.2.2.5.3 Changing the information in the status bar

The status bar displays either the Zoom (width of the window), the location of the mouse in mapper
coordinates, or the map scale.

3.2.2.5.4 Mapper behaviour when Zooming

Maplnfo either attempts to preserve the scale of the map in a mapper or displays the map at its best in the
mapper despite the size of the window.
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3226 Displaying Data
I |View |

3.2.2.6.1 The Layer Control Tool

Layer Control | Edit
 [Edi |
Layer. = Automatic
Cosmetic Layer 3 Labels
v
Add / Remove Stations [+ _‘ |Se|ect |
tables in the Sechors [+
mapper Reorder the
Layers by order
of display
— Layers Reorder
Add... | Bemove | ’V

3.2.2.6.2 The Display button

WRDWYS Dizplay Options |

— Dizplay Mode

—£oom Lavering

[ Display within Zoom Fange:

felitn, Zmon I ki
f &, Eoan I krm

[ Show Line Direction
[T Show Nodes
[ Show Centroids

F, I Cancel Help

In this instance, the default symbol assigned to the Station layer can be changed by checking the Style
Override box, and then selecting a new symbol by clicking the button next to it.

3.2.2.6.3 The Label button

This Window specifies the default for the Auto Labelling of the layer.
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Stationg Label Options Ed |

Label with: | RN ER
—Yizibility
* On g

¥ Allow Duplicate Text

" Displ ithir B 3 :
LRI =L [ Allow Owverlapping Text

il Zasons ID'DDD T Label Partial Segments

iz, Zoo; |1EIEI,EIEIEI K b aimum Labels: I—

—Shles———— —Puosition
Anchor Point

B = 5]
Label Lines :l il |:
" None il —=| il
O oSimple N 7 Rotate Label with Line
B Label Offset [2 Poirts

k. I Cancel | Help |

3.2.2.6.4 The Open New map menu
I Menu Bar -> Window -> Open New Map
Allows you to open a new mapper with the selected tables.
3.2.2.6.5 The Open New Browser menu
I Menu Bar -> Window -> Open New Browser
Open the Browser view of the selected table. This view is more the “database view” of the data.
3.2.2.6.6 Find Data
I Menu Bar -> Query -> Find Selection

This zooms to the location of an object when it has been selected in either the browser or mapper view.

3227 Create Thematic maps
I Menu Bar -> Map -> Create Thematic Map
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Create Thematic Map - S5tep 1 of 3

Pick a Tupe of Thematic kMap:

I
. Fiange-s - Ear Charts Pie Chart=
-]
'&. @] B
Graduated DOk Density Individual
Help | Cancel | Mest > I

Six categories of thematic maps are available:
Ranges: The colour represents the value of one column of a table.

Bar Charts: to display several columns together

Pie Charts: to display percentages

Graduated: to display the value of one column as a symbol, of which the
size is proportional to the value of the column

Dot Density: one dot is a defined quantity in one column

Individual: one object by colour

Step 2 of the thematic map allows you to specify the columns of which table to display.
Step 3 allows you to modify the parameters of the thematic map as well as its legend.

Modify Thematic Map

Default Legend
in () the number|
of object
selected

Preview:

=]|

— Customize

Others

nrr i+ Cu+Co % content and akb

thundance: 10 And Mi+Cu+Cox2.5

i‘-ﬁndanceﬂ 0 And Hi+Cu+Co 2-2.5

Bhundance 5-10 And Mi+Cu+Cox2.5
Bbundance 5-10 And Mi+Cu+Co 2-2.5

Modify the
number of
ranges

& Azcending

— Legend Label Order

i~ Descending

Help |

]9

Cancel

Customise the
colour or patterr

At any time you can modify a thematic map:
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I Menu Bar -> Map -> Modify Thematic Map

3228 Create and print maps
3.2.2.8.1 The Open New Layout Menu
I Menu Bar -> Window -> Open New Layout
Prior to printing the layout, objects in the MapInfo window should be displayed exactly as they are required

in the printed copy. Therefore, the user should zoom in or out as necessary in order that the relevant portion
of the map is on display prior to selecting this menu option.

Hew Layout Window |

Create a new Lapout windaw containing:

% {0ne Frame for %/indave I'W'Fi Ch S Stations,Sectors Map j
= Frames for & Currently Open Windows

i~ Mo Frames

k. I Cancel | Help |

3.2.2.8.2 The Automatic Map Creation

I Menu Bar -> PolyDat -> Layout Preview

Layout Preview |

—Scale
|1:'I,EIEIEI,EIEIEI "I
Cughom 1:|

— Paper Size
- " Paorlrait
' Landscape

v Grid IV Title Block

— Layaut Infarmation
Paper: 170 mmm x 260 mm
kap: 17000 km x 260.0 km

] I Cancel

An automatic map tools has been designed to ease the burden of creating maps. This tool requests
the user to select the paper format and the orientation. It will then display a rectangle on the current
mapper, that the user will be able to place on the desired area. After accepting the position, the tools
will automatically draw a grid, a title block, and put the different elements on the paper. The final
output is a map with an automatic scale and information about the projection used.
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3.2.3 Data Manipulation

3231 SQL Select

This is a powerful way of querying data, accessible from the Query menu. and is available when at least
one table is open. By using one or more database tables to make selections based on certain criteria, it can
be used to generate query tables, join tables, or to create derived columns, e.g. to calculate the sum of all
values in a selected column, etc.

The following requirements are necessary in order to formulate a query:
1. Name the tables that are to be used

2. Select columns from the tables to be used

3. Specify a 'where' condition

Further conditions are optional and depend on the nature of the query, which are:
4. Group by (to create subtotals, etc)
5. Order by (to place the columns that are output into a particular order)

3.23.1.1 Structuring a query

Select Columns List the columns that are required in the output query. However, until the tables
have been selected, an asterisk appears in the list, which will select all columns. In
order to select specific columns, choose a table from the next box and then come
back to the Select Columns box, which will then display a list of all available

columns.
from Tables Select from a list of tables from the drop-down list.
Where condition This specifies which records from the table(s) are to be included in the output. A

Where condition is necessary if selection involves more than one table. This is in
order that the tables are joined properly.

The Where condition is comparable to two sides of an equation, with the values in
one field of table A are equal to the values of a field in table B.

Group by Columns This groups rows in the query table so that all rows with the same values for
specified columns are grouped together.

Order by Columns Specify the order that Maplinfo lists or sorts the records in the query table. By
default, Maplinfo orders records in ascending order. This can, of course be set to
descending order if the user requires this.

into Table Named This gives the query table a name, otherwise Maplinfo assigns a default name of
‘Selection’, and windows based on this table will be labeled as 'Queryl’, "Query?2'
etc. However, although a name may have been given to the table, it is still
temporary and must be saved in order to preserve it.

Example
Select Columns Sectors.Sector_ID, Stations.Station_ID6election of columns from two different
Stations.Latitude, Stations.Longitudetables. Note that since more than one table is
Stations.Water__ Depth, being used that Mapinfo automatically
Stations.Abundance, Stations.Mn_% prefixes each column with the name of the
table it is from. Note also that each selected
column is automatically separated from the
next by a comma.
from Tables Sectors, Stations The selected tables for use in this query
Where condition Sectors.Sector_ID =Selects information from each table on the

Stations.Sector_ID AND basis of the records being connected by the
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Stations.Mn_% >0

same Sector number (Sector_id), and only
returns those records with a value for
Manganese that is greater than zero.

Group the records together by Sector number.
Return those records with the highest
Manganese value first. Note that the usual

Copy records into a table with this name.

]|

Group by Columns Sectors.Sector_ID
Order by Columns Stations.Mn_% desc
default is ascending order.
into Table Named Mn_results
S0L Select
Select Columns: Sectorz. Sector_|D, Stations Station_ID, | | Tables |£

Stationz.\Water__Depth,

Stations. Latitude, Stations. Longitude,

Stationz.Abundance, Stations.Mn_%

Colurnns |£

frarn T ables: ISec:tn:nrs, Stations

Operators |£

where Condition:  |Sectors Sector_|D = Stations. Sector_[D

AMD Stationz. Mo_% =0

Agogregates |£

Functions Ii

Group by Caluring: ISec:tn:nrs.Sec:t-:nr_ID

DOrder by Columns: IStatiDns.Mn_‘Z desc

inta T able Mamed: IMn_resuIts

[V Browse Fesults

] 4 I Cancel | Clear

ety

Help

3.2.3.1.2 Aggregate Functions

These are useful for summarizing data, and are used in the Select Columns box in the SQL Query dialogue.
For example, the Samples table contains a large amount of analytical data. The user may wish to find out
how many samples from the total number have been recorded as containing above a certain concentration
of a given element, and also what the average value is.
Examples of typical queries using Aggregate Functions:
1. How many samples taken in Santo contain more than 3 ppm gold?

2. Of the samples containing above this threshold, what is their average gold value?
3. Of the samples containing any gold , what are the maximum and minimum values?

Solutions:
1. SELECT COUNT(*)

FROM STATIONS

WHERE TEXTURE = "Smooth" AND Mn_ppm > 3
2. SELECT AVG(Mn_ppm)

FROM STATIONS

WHERE TEXTURE = "Smooth" AND Mn_ppm > 3
3. SELECT MIN(Mn_ppm), MAX(Mn_ppm),

FROM STATIONS
WHERE TEXTURE = "Smooth" AND Mn_ppm >0
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A summary table of available aggregate functions is listed below.

Aggregate Function Description

Avg() Finds the mean value of data in a specified field

Count(*) Counts the number of rows fulfilling certain criteria

Min() Finds the minimum value in a group of records for a specified field
Max() Finds the maximum value in a group of records for a specified field
Sum() Finds the sum of values within a group of records for a specified field
WtAvg() Finds the weighted average in a group of records for a specified field

For all functions other than Count(*) the field name is inserted between the brackets as they are applicable
to individual fields. Count applies to all records and so * is the only possible argument that can be held
between the brackets.

3.2.3.1.3 Joining two tables

This is required when records in one table contain related records in another table. For example, a user may
wish to retrieve details of samples relating to a specific licence area.

Example

SELECT

SECTORS.SECTOR_ID,

STATIONS.STATION_ID,

STATIONS.LONGITUDE,

STATIONS.LATITUDE,

STATIONS.SAMPLE_TYPE,

STATIONS.MN_PPM,

STATIONS.FE_PPM,

FROM STATIONS, SECTORS

WHERE STATIONS.SECTOR_ID = SECTOR.SCTOR_ID AND SECTORS.SECTOR_ID ="0001APR"
Note how each column is prefixed with the name of the table it belongs to. Also note the joining of
equivalent fields on SECTOR_ID. This is known as an 'equi-join’ since records will only be returned if they
exist in both tables for the same SECTOR_ID.

3.23.1.4 Geographic Operators

These allow the user to select objects on the basis of their spatial relationship to some other object.
Maplnfo has a special keyword that is used with geographical operators, which is "obj" or "object", which
tells MaplInfo to select values based on graphical objects.

A summary table of available geographical operators is listed below.

Operator Description

Contains Object A contains Object B if B's most central point is anywhere within the boundary of
Object A.

Contains Entire Object B is entirely contained within Object A if B's boundary is completely contained
with the boundary of A.

Within Object A is within Object B if A's most central point is anywhere within the boundary of
Object B.

Entirely Within Object A is entirely within Object B if A's boundary is entirely within the boundary of
Object B.

Intersects Object A intersects Object B if they have at least one point in common or if one of them is

entirely within the other.

A A

: [ > C

L—" \—/l/
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Object A contains Object B Object A intersects Object B Object A contains entire Object B
Object B within Object A Object B intersects Object A Object B is entirely contained
within Object A

Example

Here is a query that will pick up all samples that are contained within a given licence area.
SELECT

STATIONS.STATION_ID,
STATIONS.LONGITUDE,

STATIONS.LATITUDE,

STATIONS.SECTOR_ID,
SECTORS.SECTOR_ID,

FROM STATIONS, SECTORS

WHERE STATIONS.OBJ WITHIN SECTORS.OBJ
AND SECTORS.SECTOR_ID ="0002APR"

Result

STATION_ID LONGITUDE LATITUDE STATION.SECTOR_ID SECTORS.SECTOR_ID
3 166.58250 14.80180 0001APR 0002APR
4 166.55372 14.79613 0002APR 0002APR
5 166.55282 14.80372 0002APR 0002APR
6 166.55167 14.80632 0002APR 0002APR
7 166.63864 14.81109 0002APR 0002APR
8 166.63849 14.81269 0002APR 0002APR
9 166.55328 14.80604 0002APR 0002APR

Note that although a specific SECTOR_id was quoted in the syntax of this query, any station that have been
collected within the bounds of that Sector area are returned in the result, which is particularly useful as it
gives the user a detailed perspective of all data connected with a particular geographical region.

3.2.3.15 Logical Operators

These enable the user to make a query more specific, and allow logical expressions to be added to the
structure of the query.

Operator Description

= Equal to

<> Greater or less than

> Greater than

< Less than

>= Greater than or equal to

<= Less than or equal to

+ Plus

- Minus

* All

/ Divided by

And e.9. WHERE TEXTURE="SmoothAND Mn_% > 0
Or e.g. WHERE OCEAN_AREA ="Indian Ocea®R "Northeast Pacific"
Not e.g. WHERE Mn_%N\OT < 3

Like e.g. WHERE SURVEYORIKE "%IOM%"

Note: the % symbols either side of the word ‘|OM’ tell MapInfo to search through the records
and identify strings containing this word in the Surveyor field.

3.23.1.6 String Operators

Strings must be enclosed in double quotes. Also, when structuring an SQL Select query to include certain
fields, attention must be given to the data type of those fields; for example, the data type of SECTOR _id is
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Text, meaning that this field can contain both alphabetical or numerical characters. Therefore, when
searching for a specific SECTOR_id in a query, the value must be enclosed in double quotes.

Example

SELECT *

FROM SECTORS

WHERE SECTOR_ID = "0001APR"

3.2.3.1.7 Wildcards % and *

As seen earlier above, the % symbol was used to narrow down criteria within a search string, i.e. %I0OM%
means that Mapinfo will scan through all records containing this word in the specified field. Another
wildcard that is often used in SQL Select is the * (shift-8) symbol, e.g. SELECT * FROM SECTORS,
means 'select all records from table SECTORS.

3.2.3.1.8 Derived columns

A derived column is a column that contains the results of calculations performed on another column or
columns.

An example of such a derived value might be the calculation of the ratio between two elements in sample in
order to identify possible trends in the underlying pattern of mineralisation.

Example

SELECT STATION_ID, LONGITUDE, LATITUDE, Mn_ppm, Ni_ppm, Mn_ppm/Ni_ppm

FROM STATIONS

WHERE Mn_ppm > 0 AND Ni_ppm >0

Output:

STAE)TION_ID LONGITUDE LATITUDE Mn_ppm Ni_ppm Mn_ppm/Ni_ppm

1 168.38467 17.54024 0.38000 260.00000 684.21053
2 168.38565 17.54280 0.00500 425.00000 85000.00000
3 168.38580 17.54368 0.03500 195.00000 5571.42857
4 168.38538 17.54591 0.00800 125.00000 15625.00000
5 168.38510 17.54862 0.01200 270.00000 22500.00000
6 168.38515 17.54925 0.02200 500.00000 22727.27273
7 168.38402 17.55122 0.02000 430.00000 21500.00000
8 168.38410 17.55216 0.00800 400.00000 50000.00000
9 168.38408 17.55259 0.01500 30.00000 2000.00000
10 168.38724 17.55518 0.01200 115.00000 9583.33333
11 168.38578 17.56004 0.01200 900.00000 75000.00000
12 168.38651 17.56259 0.01700 310.00000 18235.29412
13 168.35639 17.54442 0.01300 270.00000 20769.23077
14 168.35862 17.54464 0.00700 180.00000 25714.28571
15 168.36131 17.54802 0.02800 325.00000 11607.14286

3.2.3.1.9 Column Aliases

When Maplinfo creates a derived column, the expression used in the calculation is used as the title for the
column. Since this can often look untidy and unintelligible, an alias can be used.

For example, the alias would be created thus within the above SQL statement:

SELECT STATION_ID, LONGITUDE, LATITUDE, Mn_ppm, Ni_ppm, Mn_ppm/Ni_ppm “Ratio of
Manganese to Nickel”

FROM STATIONS

WHERE Mn_ppm > 0 AND Ni_ppm >0

The required calculation would be done and the result stored in a new column with title “Ratio of
Manganese to Nickel”.
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3.2.3.1.10 Keywords

These keywords can be used in SQL Select expressions, and their uses are summarized below.

Keyword Meaning

Any To select any item in a set of items

In To select records relating to a list of possible values

Between To select records containing values within a certain specified range
Any

SELECT *

FROM SECTORS

WHERE OCEAN_AREA = ANY ("INDIAN OCEAN", "NORTHEAST PACIFIC", "SOUTH PACIFIC ")
In

SELECT SECTOR_ID, SURVEYOR, OCEAN_AREA

FROM SECTORS

WHERE OCEAN_AREA IN ("INDIAN OCEAN","NORTHEAST PACIFIC")

Between

SELECT *

FROM STATIONS

WHERE Mn_ppm BETWEEN 100 AND 200

3.23.2 Using Surfer contouring software to visualize geochemical data

This software enables the user to convert sample point data into interpolated areas, in order that any

chemical trends become more apparent. This is particularly useful in the identification of regions of high

concentration of a particular chemical element.

1. In Maplinfo, make sure that the Stations layer is visible. For a particular cluster of stations that are of
interest, click the Marquee select button, and then click and drag to select stations points. Then, click
the Browser button to view the selected stations. This viewer will be labeled at the top left-hand corner
with the name of the query, e.g. Queryl.

2. In order to use Surfer, data needs to be in an X Y Z format, where X and Y are locational parameters, in
this case Longitude and Latitude, and Z is the value to be modeled, which in this case will be the
abundance. Therefore, in order to put the data into the required format, SQL Select is used to extract
only those columns that are needed.

From the Maplinfo Query menu, choose option SQL Select.
An example of typical syntax might be:
SELECT LONGITUDE, LATITUDE, ABUNDANCE
FROM QUERY1
WHERE ABUNDANCE>=0
followed by OK.

3. The resulting browser would then be exported in ASCII format; from the Table menu, select Export,
naming the table as Abundance for example. When using ASCII, a tab delimiter is used to separate the
columns, so make sure that this is selected in the resulting dialogue window, and check the box that
reads 'Use first line for column titles'.

4. Now leave Maplinfo by either closing open objects or by minimizing the window. Start Surfer by
navigating to Golden Software, Surfer32 from the Start button located at the bottom left-hand corner of
the screen in the Windows 95 interface.

Prior to a contour, surface or other plot being produced, the data has to be gridded. This is in order that a

regularly spaced pattern of Z values can be produced from data that may not have been sampled on a

regular grid spacing, and therefore the gridding procedure generates a Z value at each X, Y location on the

grid by interpolation or extrapolation, i.e. gridding fills in the gaps where no Z value data exists.

5. To produce a grid, select menus options Grid, Data, and navigate to the directory where the ASCII file
is stored, select it and press the OK button. A window will now be visible; at the top there are three
boxes for the user to indicate which columns from their ACSII file will be used as X, Y and Z. There is
also a Grid Line Geometry section which determines the grid spacing. This is usually pre-determined by
the program, but can be altered by the user.
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The gridding method can be selected from a drop-down list. However, Kriging is the default gridding
method because it generates the best overall interpretation of most data sets and is flexible in that it can be
used to grid almost any type of data set, whether the data is regularly or irregularly spaced.

Another likely gridding method to use with large geological data sets would be Triangulation with Linear

Interpolation. The main advantage of this method is that if there is enough data, any break lines that exist

will be preserved. For example, if a fault is delimited by enough points on either side of the fault line, the

grid generated by triangulation will reveal its presence.

6. Finally, prior to the grid being produced, the user must assign a name to the grid file, by clicking the
Browse button and navigating to the directory where the grid file is to be stored. To start gridding, press
the OK button.

When a grid has been produced, the resultant data can be visualized in a number of ways, including

contour, shaded relief or surface plots. The commands for these are accessed from the Map menu.
| |
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An example of a contour plot displaying Abundance of Nodules concentration in kg/sgm and Stations
points as crosses.
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3.2.4 Polydat Menu and Toolbar
3241 PolyDat Menu
This menu has several options, which are summarized below.

3.24.1.1 Rebuild All

This option should be taken if the user has just finished entering both Sectors and Station information from
within the database in Access. This command looks up new records, which have been input to the Sectors
and Stations tables, and builds spatial objects from Latitude and Longitude values in these tables.

3.24.1.2 Rebuild Sectors

This option should be selected if the user has entered Sectors data. This command will then build polygon
objects representing the additional Sectors areas. The system stores also the sector area in the appropriate
field in the sectors table.

3.2.4.1.3 Rebuild Stations

This option should be selected if the user has entered sample data. This command will then build point
objects representing the additional Stations.

3.2.4.1.4 Stations Entry

On selecting the Stations entry command from the PolyDat menu in Maplinfo, the operator works on the

Stations Table in Read/Write Mode. A browser corresponding to the Stations Table opens and the operator
should select the Station to be located and then immediately shift to the map view where the Station

location should be pinpointed. Care should be taken to ensure that Stations that have already been
referenced are not re-referenced by mistake.

3.24.15 Geocode Stations

When all Stations have been referenced, the operator must then select this command, which fills in the
Longitude/Latitude fields in the Stations Table by picking up the values in MaplInfo and transferring them
into the Stations table in the database.

3.2.4.1.6 Querying Facilities

This provides the user with a menu screen on which many options can be set in order to execute a number

of custom queries. The user selects a variety of combinations of these values from picking lists and then
presses the appropriate query button to obtain the required information.
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After selecting the required criteria and the relevant button, the menu com@aeds Find Selection

enables the result to be viewed. Also, three of the queries involve the creation of thematic maps, and a
symbol has to be selected in addition to the other criteria prior to the running of the query. If a symbol is
not selected, the default is used, as seen above.

3.24.1.7 Map Projection

On clicking this option, a window opens, containing useful map projections of the world, which the user
can select and view on-the-fly.

World Map Projections |
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3.2.4.1.8 Map View

On selecting this option, the user is presented with a window containing a list of ocean area. The mapper
automatically zooms in when one has been selected.
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3.2.4.1.10 About and Exit

The About command presents the user with an information window and Exit quits the user from the
application.

3.24.2 PolyDat Button bar

Many of the options from the Minerals menu are available from a custom toolbar. The last button is
available only in the toolbar, it allows the user to retrieve turning points co-ordinates of the sector selected
by the user.
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4 Recommendations

4.1 Data Format

The data format to be supplied to the authority should be based on the description of the tables Sectors and
Stations. The data should be saved in this order of preference: Mapinfo Interchange Format, Excel or
ASCII delimited. Station co-ordinates and turning points should be added to the file if the format doesn’t
recognise geographical objects.

4.2  Printer Memory
The DesignJet 650C should receive as soon as possible more memory, as it was clearly identified in the
beginning of the mission that the printer was lacking resources for PolyDat output and map production.

4.3  Acquire Surfer
For the moment ISA uses an evaluation copy of Surfer from Golden Software. It is suggested that ISA
acquires as soon as possible a licensed version of Surfer.

4.4  Methodology Application

It is recommended that ISA apply as soon as possible a methodology for data and information reception to
all participants in Polydat as to ensure the accuracy of the data entered. This methodology should be
submitted to the Legal and Technical commission for approval.

4.5 Creation of a GIS Unit

A Computer System Manager should be recruited as soon as possible to allow the current persons to
concentrate on GIS work and data entry. It is important that the unit is left with autonomous responsibilities
on the accuracy of the data and that the maintenance of the computer system should be under the
responsibility of the Computer System Manager with its own budget, and purchase orders... It has been
detected that the computer system may fail due to administrative interference.

4.6 Marine Geologist

A marine geologist should be attached to the GIS unit, to interpret the data and produces relevant
documentation in conformity with the goal of the ISA. This marine geologist will ensure the independence
of the interpretation of the data and will preserve the confidentiality.

4.7 GIS Unit active at the Legal and Technical commission

The GIS unit should be an active part at the legal and technical commission to ensure that the
recommendations are understood and applied. Also, the GIS Unit should be able to inform the legal and
technical commission about the resources available in the ISA.

4.8 Acquisition of classification criteria for queries.

It is recommended that ISA collect a set of criteria for nodule classification to implement in Polydat.
Unfortunately this information was hardly available from the geologist consultant and basic classification
criteria were applied. The recruited Marine Geologist should be able to supply such classification criteria.

4.9 Collect and enter supplemental data

It is recommended that the ISA seeks copies of the data of the non-reserved area as well as for other areas
part or not of the Area. This data should be entered as soon as possible in PolyDat so ISA would own a
complete dataset.

4.10 Cooperation with National Agencies

The ISA should seek cooperation with National agencies such as the NOAA and the USGS, to exchange
data and avoid duplication of resources in nodules GIS. It is noted that it is not clearly known which data
sets the former east block owns, and it could be an advantage for ISA, if these nodules and marine related
data sets could be included in PolyDat.

41 of 45



4.11 Map Production

ISA should start to produce a map set to promote the potential of nodules exploitation to all its member

countries. This map set should be of professional quality with the help of a cartographer and through
printing services.
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5 Glossary of Terms

Attribute

Term used in database design to describe different pieces of information about an entity; for example, a
Sector is an Entity (something that information is stored about) and an example of one of its attributes
would be the Sector ID.

Bound Control
An object on a form or report whose contents is based on a field in an underlying table or query.

Command Buttons
A button on a form that carries out a certain function; for example, all forms in Polydat have a Close
button. Some forms have other buttons on them that open other forms.

Caption
The name that is displayed at the top of a form or report window, or the label of a field on a form.

Check Box

A control on a form that stores a ‘Yes/No’ value. For example, the Report Form has check boxes on it in
order that the data inputted can record whether or not a report contains maps or field notes etc. When
checked, a cross appears in the box, which is stored as a ‘Yes.’

Combo Box

This is a scrolling list of values that the user can pick from when inputting data, and its advantages are
similar to a List Box, except with many Combo Boxes, the user can input a new value if the required one is
not already in the list.

Criteria

A set of limiting conditions used in a query to restrict the output to a specific group of records. For
example, many of the queries in Polydat require the user to select a value from a list prior to running their
selected query.

Data Type

This determines what kind of values are allowed in a field. For example, text cannot be stored in a field
with the Number data type.

Common data types include, Text, Number, Date/Time and Yes/No, but there are many more.

Datasheet
Data from a table, form or query displayed in a row-and-column format, similar to a spreadsheet.

Design View
A window displaying the design of a table, form, query or report. In this view, existing objects can be
modified, and new ones can be created.

Entity

Term used in database design to describe something about which information is known. For example, A
Prospecting Licence is an Entity, and its attributes include the Prospecting Licence Number, Date of issue,
Fee paid etc.

Focus
This refers to the most current cursor position on a form. Whichever field on a form has the cursor in it is
said to have the focus.

Form
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A form is a screen where a user can input and edit information. The form is based on a table, meaning that
when data is typed into the form, it is stored in the underlying table. Forms may sometimes be based on
more than one table, i.e. a query.

Form View

This is the view of the form that the user sees when opening a form and entering data. Forms have two
other kinds of view; design view, which is the layout of the form’s design without the display of underlying
data, and datasheet view, which is a view of the data the form is based on, in row-and-column format,
similar to a spreadsheet.

List Box
This is a simple list of values that the user can select from, instead of having to type them in. The main
advantage is that data will always be input correctly and consistently if a list is used.

Navigation Buttons
In form view at the base of the screen, there is a horizontal scroll bar containing buttons that are used to aid
navigation through data.
[14] « |F’iec:u3rd:|1 |Df g D m]
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Go to next record
Go to specific record (user types which one in box shown)
o to previous record
0 to first record

One-to-many Relationship

A one-to-many relationship is the most common type of relationship in a relational database. In a one-to-
many relationship, a record in Table A can have more than one matching record in Table B, but a record in
Table B can only have one matching record in Table A. A typical example of this kind of relationship is

that between Sector and Station in Polydat; a Sector may have one or more Station associated with it, but in
order for a Station to be stored in the database, it must be linked to a Sector.

One-to-one Relationship

In a one-to-one relationship, a record in Table A can have no more than one matching record in Table B,
and vice verse. This kind of relationship is unusual, but an example might be of a database containing
employee salary details, with one table containing personal details such as name and address etc, and the
other table containing the person’'s name, manager and current salary; in this instance there would be a one-
to-one relationship between the two tables.

Query

Queries enable the user to retrieve data from their database that matches certain conditions or criteria; the
data that is retrieved depends on the structure of the query. Queries are an efficient way of viewing related
data from several different tables at once.

Read-only
In Polydat, some of the results of queries are all set to be 'read-only' meaning the data cannot be altered, but
only viewed on screen.

Record Selector

Within a data entry form, the left-hand side of the form often has a small box containing different symbols
denoting the status of a record in the database, i.e.

Record that is currently being viewed, which has already been saved

New Record
Record edited but not yet saved - changes can be undone by pressing ‘Esc’
Record being edited by another user

[SlF=]F*i+]
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Relationship
An association between common fields (columns) in two tables. For example, the Sector and Sample tables
are related on Sector ID.

Report
Output of data from a query or table in Microsoft Access in document form.

Scroll Bars

A typical Windows-style control, which aids the user to view different parts of the screen or navigate their
way through a combo box. Scroll bars can either be vertical, appearing at the right-hand side of the screen,
or horizontal, appearing at the base of the screen.

Security
A set of features used to specify or restrict the access that specified users or user groups have to data and
objects in a database.

Source
Each form, report, query and every individual field on each of these objects has this property, referring to
which underlying table or part of a table its data is derived from.

Switchboard
The initial screen that the user is presented with after logging onto Polydat Database. It is from this screen
that they navigate their way around the system.

Tab Order
The order in which the cursor moves from one field to the next on a form on pressing the Tab or Enter key.

Table

The fundamental structure of a relational database management system. In Microsoft Access, a table is an
object that stores data in records (rows) and fields (columns). The data is usually based on one particular
category, or ‘entity.’

Text Box
A control that provides a place to enter or view text in a form or report.

Validation Rule

A rule that sets limits or conditions on what can be entered in one or more fields. Validation rules can be set
for a field, record or control on a form. The rule is checked when the focus moves from one field or control
to the next. Microsoft Access displays a different message whenever the rule is violated.

Wizards

A Microsoft Access tool that asks the user questions and creates an object according to his or her responses;
for example, tables, queries, reports, forms, and controls on forms such as buttons and combo boxes can all
be created quickly using Wizards.
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